
   

United States Court of Appeals for the Federal Circuit 

 

 

CM/ECF  
User Guide 

 

 

 

 

 

 

 

717 Madison Place, NW 

Washington, DC  20439 

ECF Help Desk: ecfHelp@cafc.uscourts.gov  

Web Site: www.cafc.uscourts.gov 

ECF HELP DESK 8040 • W 

JULY 2012 



C M / E C F  U S E R  G U I D E  V e r . 1 . 6  P a g e  | 2 

 

    
 
 
 
 
 
 
 
 
 

 
 
 
 

[THIS PAGE INTENTIONALLY LEFT BLANK]

U . S .  C O U R T  O F  A P P E A L S  F O R  T H E  F E D E R A L  C I R C U I T  



C M / E C F  U S E R  G U I D E  V e r . 1 . 6  P a g e  | 3 

 

REVISION HISTORY 

 
 
 

Version         Date    Revision       Author   Comments 

1.0 May 16, 2012         1   ITO-CAFC Public Release 

1.1 August 15, 2012         2   ITO-CAFC Public Release 

1.2 August 23, 2012         3 ITO-CAFC Public Release/ 
Upgrade to  
CM/ECF 5.1  

1.3 
January 14, 2013         4 ITO-CAFC Public Release/ 

Upgrade to 
CM/ECF 5.2 

1.4 March 3, 2013         5 ITO-CAFC Public Release 

1.5 April 1, 2013         6 ITO-CAFC Public Release 

1.6 July 12, 2013         7 ITO-CAFC Public Release 

U . S .  C O U R T  O F  A P P E A L S  F O R  T H E  F E D E R A L  C I R C U I T  



C M / E C F  U S E R  G U I D E  V e r . 1 . 6  P a g e  | 4 

SUMMARY OF CHANGES 

CM/ECF User Guide version 1.1 

Page22 Operating System (MAC Users).  We have included new instructions for  

  Mac users who install OSX Update 9. 

Page 35 Item 10 was changed from “contact the case manager” to contact the   

  Clerk’s Office. 

Page 29 Item 8 was changed to instruct the user how to view a document prior   

  to committing the transaction. 

Page75 The TIP was changed:  Six “bound” paper copies of all briefs in the   

  format specified by the Federal Rules of Appellate Procedure and the   

  Federal Circuit Rules, must be filed with the court within 5 days after   

  the brief has been accepted for filing by the court.  See. ECF-10, Paper  

  copies of Electronic Filings of the Administrative Order.  

Page88 New section on How to File a Petition for Rehearing or Hearing/Rehearing  
  EnBanc. 

  New Figure 64 – Filing a Petition.  
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  Forms and Certificates – comments updated 
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Page 96 Attorney – comments updated 
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CM/ECF User Guide Version 1.2 / CM/ECF v. 5.1 
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Page 79 Updated Figure 55 to show the new “view” button. 
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CM/ECF User Guide Version 1.3 / CM/ECF v. 5.2 

Page 22 Message removed advising filers not to use Java 1.7 

Page  93 Letters and Notices – list updated to add Citation of Supplemental Authority 

CM/ECF User Guide Version 1.4 / CM/ECF v. 5.2 

Page 22 Updated the minimum Java requirements to version 7 update 11. 
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CM/EFC User Guide Version 1.5/ CM/ECF v. 5.2 

Page 23 Updated file size upload limit from 20 MB per upload to 60 MB per upload; 

Deleted 80 MB total upload limit. 

CM/ECF User Guide Version 1.6 CM/ECF v. 5.2 

Page 33-41 Updated “How to File Brief or Appendix” to include type of brief being filed 

drop-down. 

Page 56 Updated event list to include Response to Request from Panel at Oral Argument 

event. 

Page 59 Updated event list to include Response/Opposition with Incorporated Motion 
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INTRODUCTION 

Case Management/Electronic Case Filing (CM/ECF) is an automated case 
management system that allows the public to file documents over the Internet and 
provides courts with the ability to make electronic documents available to the 
public through the Public Access to Court Electronic Records (PACER) program. 
Except as otherwise prescribed by local rule or order, all cases will be assigned to 
the court’s electronic filing system. Effective May 17, 2012, use of the electronic 
filing system is mandatory for all attorneys filing in this court, unless they are 
granted an exemption, or are pro se litigants. Pursuant to Federal Rules of 
Appellate Procedure 25(a) (2)(D) and 25(c), and Federal Circuit Rule 25(a), 
the United States Court of Appeals for the Federal Circuit has authorized the filing 
and service of documents by electronic means. To implement (CM/ECF), the court 
hereby adopts the provisions contained in the Administrative Order dated May 17, 
2012 that will govern the conduct of parties in filing documents electronically with 
the court. These provisions may be amended as necessary.  Click here to access 
Administrative Order regarding e-filing. 
 
The CM/ECF system is easy to use; a filer creates a document using conventional 
word processing software and converts it to Portable Document Format (PDF). 
After logging in to CM/ECF, the filer enters basic information relating to the 
document, attaches the PDF file and submits it to the court.  A notice verifying 
receipt of the filing is automatically generated and emailed to the other case 
participants who have registered for Appellate ECF, except in confidential filings.  
There are no additional fees for filing documents using CM/ECF. Litigants receive 
one free copy of documents that are electronically filed in their cases, which they 
can save or print. Additional copies are available through PACER at a cost of $0.10 
per page, with a maximum charge of $3.00 per document. Copies of court opinions 
are available at no charge and are available via PACER or the Court’s website 
www.cafc.uscourts.gov.  All filers must redact social security or tax identification 
numbers; dates of birth; names of minor children; financial account numbers etc., in 
compliance with Fed Rule of Appellate Procedure. 25(a)(5) and 
Administrative Order Regarding Electronic Case Filing, ECF-12. 
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GLOSSARY OF TERMS 

Browser: A software application used to access, display and interact with web 
pages. Two common browsers are Microsoft Internet Explorer and Firefox. 
 
Case Management/Electronic Case Filing (CM/ECF): An automated case 
management system that allows the public to file documents over the Internet and 
provides courts with the ability to make electronic documents available to the 
public through the Public Access to Court Electronic Records (PACER) program. 
 
Confidential Document:  A public document characterized by limited electronic 
access whose contents are not available to the public and which may be filed in both 
public (redacted) and confidential form.  Electronically filed confidential documents 
are available only to the court. Restricted documents may be available to other 
interested persons in paper form, or on the public terminal located in the Clerk’s 
Office. Please refer to the Administrative Order Regarding Electronic Case Filing, 
ECF-9, as well as the Federal Circuit Rules of Practice, for information regarding 
the filing and treatment of confidential materials in proceedings before this court. 
 
Docket Report: The formal record of a case, kept by the Clerk of Court, listing the 
case number, case type, case caption, nature of suit, fee status and date docketed; 
parties and other case participants; attorneys; originating case information; 
associated appellate cases; and all public docket entries in the case. 
 
Docket Entry: An entry on the docket describing a document in the case or action 
taken by the court. 
 
Docket Text: The text of a docket entry. 
 
Document: An order, opinion, judgment, petition, application, notice, transcript, 
motion, brief or other document filed with or entered by the court. 
 
Electronic Filing (E-Filing): The process of using CM/ECF to upload a document 
from the filer’s computer and submit it to the court via the Internet. 
 
Native PDF Files: A native PDF file is created by electronically converting a word 
processing document to PDF using Adobe Acrobat or similar software. Native PDF 
documents are text searchable and their file size is small. 
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Notice of Docket Activity (NDA): An email notice that is generated 
automatically by the CM/ECF system at the time a document is filed electronically.  
The notice sets forth the time of filing, the name of the party filing the document, 
the text of the docket entry created by the filing, a hyperlink to the PDF document 
filed and to the docket report, and the name of the participants required to receive 
notice of the filing. 
 
Operating System: An interface that translates user input into instructions for 
the hardware components of a computer. 
 
Portable Document Format (PDF): A file format created for document 
exchange. CM/ECF only accepts documents in Portable Document Format (PDF). 
PDF documents up to 20 megabytes can be uploaded as one file. Larger documents 
should be split into separate files with appropriate identification. There are two 
types of PDF files, native PDF files and scanned PDF files. All pleadings must be 
submitted as native PDF files. Attachments to pleadings may be submitted as 
scanned PDF files if the original word processing document is unavailable. 
 
Public Access to Court Electronic Records (PACER): An automated, fee 
based system that allows subscribers to access electronic documents and obtain 
case information from the federal courts via the Internet. 
 
Scanned PDF Files: A scanned PDF file is created by scanning a paper document 
with an optical scanner. Scanned PDF documents are not text searchable and have 
a large file size. 
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HARDWARE AND SOFTWARE REQUIREMENTS 

• Operating System: You need a PC or a *Mac computer. The Apple 
Macintosh platform: Intel-based, 64-bit capable, running OS X Snow Leopard 
10.6 (or higher) is required. *Apple Macintosh users running MacOS® 10.x or 
later do not require the complete Adobe Acrobat product. 

Note: Mac users who install OS X Update 9 will have to re-enable the Java 
Applet.  The Update brings Mac Java up-to-date with the latest revision; 
however, it also automatically configures web browsers to not automatically 
run Java applets. 

Instructions to re-enable the Java applet can be found at Apple’s link here: 
  http://support.apple.com/kb/HT5241 

Additional information can be found at this Apple link: 
 http://support.apple.com/kb/DL1550 
 

• Screen Resolution: The minimum recommended screen resolution is 1024 
x 768 pixels. If the screen resolution is lower, relevant information may not 
readily display without horizontal scrolling. 

 
• Internet: A cable modem or digital subscriber line (DSL) is recommended. A 

dial up connection is technically feasible, but it will be too slow for most 
users. 

o Mozilla Firefox (versions 3.5 and 3.6) 
o Apple Safari (versions 4.x and greater) 
o Internet Explorer (versions 7 and 8) 

NOTE: Java Software Requirement: Java Version 7 Update 11 (or 
higher) is required to operate CM/ECF. To verify you have Java, click here, 
https://www.pacer.gov/psco/cgi-bin/cmecf/ea-regform.pl. If you need to 
download or update Java, click this link 
http://www.oracle.com/technetwork/java/javase/downloads/index.ht
ml 

 
 

• Internet Cookies: To operate CM/ECF, your browser must be set to accept 
all cookies. The instructions for enabling cookies will vary, depending on the 
browser you are using. Select the Help option on your browser’s tool bar to 
find the appropriate instructions for your system. 
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• Pop-Up Blocker: To operate CM/ECF, your pop-up blocker must either be 
turned off, or set to allow pop-ups from https://ecf.cafc.uscourts.gov. 

 
• Word Processing Software. You can use WordPerfect, Microsoft Word or 

any other word processing software that will allow you to convert text 
documents to PDF. 
 

• Scanning.  You will need a Scanner for imaging documents which do not 
exist in electronic format.   It is recommended that any paper document 
that an attorney intends to file in ECF should be scanned at 300 to 600 pixels 
per inch (PPI). This is to ensure that the scan produces a high quality 
document with a file size that does not hamper the length of time it takes to 
scan, load, and retrieve documents.  

 
• File Size Limitations.  There are document file size limitations when 

filing on ECF.  You may file a maximum of 60 megabytes per upload. If 
your file is too large, the system will reject it.  The recommended solution 
is to separate an oversized file into 2 or more parts and docket it in a 
single event.  It may be best to label each file 1, 2, 3, etc... See dividing a 
PDF for further guidance. 

PDF Related Topics   

 
• PDF Conversion Software: You will also need an application that will 

allow you create and save PDF documents, such as, Adobe Acrobat® 6.0 or 
higher.  To view and print documents, only Adobe Reader® is required, but in 
order to create PDF (portable document format) files, the complete Adobe 
Acrobat software package (includes Reader and Writer) or other PDF 
creation software (the court does not recommend any one program in 
particular)  must be installed on the computer.  WordPerfect version 9 and 
higher include the capability to convert text documents to PDF by selecting 
File > Publish to PDF from the toolbar. Microsoft Word does not include 
PDF conversion software, but you can use Adobe Acrobat Writer, or download 
PDF conversion software from another source. A computer based training 
course on converting documents to PDF is available on the PACER website. 
To view the training module, go to  http://www.pacer.gov/ecfcbt/ap/ . 

 

• Document Conversion. Wherever possible, you should create PDF files 
directly from a word processing program. When you create a PDF file from a 
scanned paper document, the file size is significantly larger. This may 
prevent you from filing it as a single document on the ECF system and will 
also take up unnecessary computer memory on your computer system. In 
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addition, it is easier and more convenient to create a PDF directly from a 
word processor. 

 
• Optimization.  All PDF files should be “optimized” for viewing over the 

Internet. When a non-optimized PDF document is accessed via the 
Internet, the browser attempts to download the entire document before 
displaying any of the text. For large documents or slow Internet 
connections, this can result in an extremely long wait period before the 
document will open. To address this performance issue, documents should 
be “optimized” for efficient downloading. When optimized, the browser 
will start displaying the first page as it is downloaded, allowing the user 
to begin reading the document, while the remainder of the document 
finishes downloading in the background.   

• Text Searchable PDF.  All PDFs submitted to the Court must be text-
searchable per ECF-7(B).  See How to make a PDF searchable  
 

• Page Numbers. Your documents page numbers may change after 
converting to PDF. This is called "flowing." Depending on the font, the 
printer selected, and other characteristics of the content, a document may 
undergo some changes when it is rendered into PDF. If you are using an 
Adobe product to convert documents to PDF, visit www.adobe.com. Adobe 
has a set of technical documents posted on its site that refer directly to 
ways in which you may attempt to address flowing problems. Another 
workaround is to set your PDF printer as your "Default Printer" before 
opening the document. After you have changed the default printer, open 
the document, edit it to correct any formatting errors, save the document, 
and try printing (converting) to PDF again. 

 
• Redaction.  It is the responsibility of the party to redact any and all 

sensitive material from the documents submitted electronically or in 
paper to the court.  Sensitive material includes social security or 
taxpayer-identification numbers, dates of birth, names of minor children, 
and financial account numbers (See Fed. R. App. P. 25(a)(5); 
Administrative Order Regarding Electronic Case Filing, ECF-12).  See 
Redaction for further guidance. 

 
• Email Account: The size of your email account must be sufficient to 

receive NDAs. This may exceed the size allocated for free email accounts. 
In general, an account with storage space of at least 100 megabytes is 
sufficient. You must insure that the spam filter operation on the network 
and computers receiving the e-mail are set to allow notices from 
cmecfmailuser@cafc.uscourts.gov .  
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• ECF Security. ECF has many security features and has passed an 
evaluation by the National Security Agency. However, in registering as 
an ECF filer, you agree to protect the security of your password.  

 
• Contact the PACER Service Center (800-676-6856) or the Clerk’s Office  

via e-mail (preferred) at ecfhelp@cafc.uscourts.gov or call (202) 275-
8000 immediately if you learn that your password has been compromised. 
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HELPFUL CM/ECF LINKS  

About CM/ECF 

CM/ECF General Information 

CM/ECF User Information 

General CM/ECF FAQs 

PACER Service Center 

CAFC CM/ECF FAQs 

 

REGISTRATION  

For the most current information on registration and the implementation of 
CM/ECF at the Federal Circuit, visit the court’s website at www.cafc.uscourts.gov. 

To be eligible to e-file at the Federal Circuit, filers must have established the 
necessary accounts through the Pacer Service Center. Both a Pacer account and 
CM/ECF account are required. For more information on obtaining the required 
accounts, please visit the Pacer Service Center at http://www.pacer.gov 
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LOGGING INTO THE ECF SYSTEM 

1.  Check the box to the left of the text, I understand that, if I file, I must comply    
     with the redaction rules. 
 
2.  Enter your Login name and password in the appropriate boxes on the Login           
     screen. Click “Login” to proceed. 
 
3. The “Client Code” is only used if you already have automatic login to PACER      
     set up and would like to track billing on a shared account. It provides a  means    
     to track charges on future filings. For more information browse  
     to: http://www.pacer.gov/documents/pacermanual.pdf 
 
4. Verify that you have entered your ECF login and password correctly.   
 
5. If an error has been made, click on the "Clear" button to erase the login and       

re-enter the correct username and password and click on “Login”.   
 
NOTE: You have 5 login attempts until your account is locked; if this happens, you 
must wait 5 minutes to allow for the system to re-enable your account.   
 
TIP: Your login credentials are case sensitive.   If you have forgotten your 
password, go to the PACER Service Center website at http://www.pacer.gov 
and select E-File.  To retrieve your password you will be asked to enter your 
username and email address or DOB on record.  If you have forgotten your 
username, you must enter your last name, DOB and email address.  After entering 
valid data you will receive a link to retrieve your password online in the email 
account you have on file. See the Figure 1. - Appellate CM/ECF Login page sample 
below: 
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Figure 1.Appellate CM/ECF Login Page 

 
 
 
 
The Startup Page will appear upon successful login to the system. 
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Figure 2. Startup Page 

 

 

 

 

 

 

 

  

U . S .  C O U R T  O F  A P P E A L S  F O R  T H E  F E D E R A L  C I R C U I T  



C M / E C F  U S E R  G U I D E  V e r . 1 . 6  P a g e  | 22 

Figure 3. Filing Select an Event 

 
 
The menu options on the top of the screen are as follows:   

1. Filing - Select to file in a case; 
2. Reports - Select to be connected to PACER;  
3. Utilities - Select to edit/update your Account Information;  
 

o Check PDF document utility is here, It is available for filers to 
check whether a PDF document is valid (size, security etc…) before 
filing a document. Once selected, the screen allows the user to 
browse and select any PDF document from their file system.  An 
error message will be displayed if there is an issue with the PDF.   
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ADDING A CASE TO YOUR NOTICE LIST  

  Figure 4. Menu Bar 

 
 
1. Select Utilities from the menu bar.  
2. Select Notice for Cases of Interest.  
3. The Notice for Cases of Interest screen will appear.  

Figure 5. Adding a Notice of Interest 

 
 

4. Enter the e-mail address or select an on-file e-mail address from the 
drop down menu where you want notices delivered. Only one e-mail 
address may be selected for notice in cases of interest.  

5. Enter the appellate case number of the case you are interested in.  
6. Click Search & Add.  
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7. The case number and title will appear in the Cases of Interest Selected 
box. 

8. Click Update.  
9. Click OK to confirm update.  
10. Add any other case numbers you wish to receive notice of by following 

steps 5 through 9 for each case.  
11. Click Done after adding all cases of interest.  
 

• Removing a Case From Your Notice List   
1. Select Utilities from the menu bar.  
2. Select Notice for Cases of Interest.  
3. Left-click the case number and title of the case you wish to remove.  
4. Click Remove.  
5. Click Yes to confirm removal of the selected case.  
6. Click Update.  
7. Click OK to confirm update.  
8. Repeat steps 3 through 6 for all cases you wish to remove from your 

notice list.  
9. Click Done.  

 
4. Logout- Select to end your session. 

Figure 6. Logout of CM/ECF 

 
 
5. HELP- Select the Help Menu for assistance 

Figure 7. Help 

 
 
6.  For additional information select the Court Information link at the bottom of 
the screen. 
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Figure 8. Additional Help Link 
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ESTABLISHING A LINK BETWEEN ECF AND PACER  

After your ECF registration has been approved by the court, you will need to link 
your ECF account to your PACER account. This is quite important, as it will be the 
only way you will be able to view sealed pleadings in a case if you are the counsel of 
record.  You will only need to do this once. To link your accounts, please do the 
following: 
 
1. Log into ECF. 
2. Select PACER Report from the Reports Menu.   

3. The PACER login screen will appear. Enter your PACER login and 
    password, and check the “Make this my default PACER login” box. 
4. Click Login. 

5. You will need to log out of ECF and log back in for the change to take effect. 
You will now be able to access PACER from your ECF account. You will not be able 
to view sealed documents in your case if you access the docket via the PACER site; 
you must access via your ECF account. If you are with a law firm that has a single 
shared PACER account, you may use that shared account to link to your individual 
ECF account. 

 
 

USING CM/ECF 

Overview of Filing a Document 

1. Prepare the document you want to file and convert it to PDF. 
 
2. Select Filing > File a Document from the menu bar on the Startup Page. The  
    File a Document window will open. 
 
3. Enter the case number in the Case field and press the Tab key. 
 
4. Select an Event Category radio button on the left side of the screen. The category 
    you select will determine which document options are available on the right side 
    of the screen. Some document options may be listed under multiple categories. 
    For a complete list of the document options available under each category, refer 
   to the Event and Relief Category list . 
 
5. From the right side of the screen, select the option that best describes the 
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    document you are filing. 
 
6. A dialog box containing one or more warning messages may open after you click  
    Continue. If this happens, please read the message(s) carefully. They are 
    designed to help you avoid some of the more common errors associated with the 
    type of document you are filing. If you realize an error was made, cancel the 
    transaction and make the necessary corrections before proceeding.   
 
7. The configuration of the screens that display after you click Continue on the 
    File a Document screen will vary based on the document filing option you 
    select. Each screen is made up of individual sections. The sections are identified 
    by a blue header bordered by a thin gray line.  The sections are relevant to the 
    types of filing, and may not be part of every docketing transaction. Enter the 
    requested information in each section and click Continue to proceed to the next 
    screen until the Docket Text dialog box opens. For further information on 
    navigating the individual sections that comprise the various docketing screens, 
    refer to the Navigating Specific Docketing Screens Section. 

 
8. If the Docket Text dialog box contains a free text field or drop down menu, enter  
    or select the appropriate information. 
 
9. Click Continue to open the Event Review dialog box. Please review the 
     information in this dialog box carefully before completing the transaction. Verify 
     the docket text is complete and you are filing the correct document.  The case 
     number associated with the document that is being filed will be indicated in 
    brackets at the end of the docket entry. You will not be able to edit the text on 
this screen, 
     but errors can be corrected by using the Back button to modify previously 
     entered information. If you want to cancel the transaction, click Back, followed 
     by Cancel. 
 
10. Once you have verified the docket entry is correct, click Submit. This is the 
      point of no return. If you realize an error was made after clicking the Submit 
     button, contact the Clerk’s Office for assistance. 
 
11. The Event Docketed dialog box will open. Click OK. 
 
12. A browser window will open displaying the NDA for your filing, which you can 
      save and/or print. This is your proof that the transaction was accepted by the 
      court. 
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Navigating Specific Docketing Screens 

The configuration of the screens that display after you click Continue on the File 
a Document screen will vary based on the document option you selected. Each 
screen is made up of individual sections. The sections are identified by a blue 
header and surrounded by a thin gray line that begins and ends on either side of 
the header. The Note, PDF Document and Service sections appear in most 
docketing transactions. The Additional Information, Attorney Filer, 
Party Filer, Related Previous Entries and Relief sections are relevant only for 
specific types of filings, and will not be part of every docketing transaction. 
 
Additional Information: 
 
The Additional Information section uses either a free text field or drop down 
menu to collect additional information from the filer.  
 
Attorney Filer The Attorney Filer section is used to indicate the attorney filing 
the document. It lists the attorneys associated with the selected case(s); the party 
type they represent; the case number; and the short caption. 
 
Party Filer The Party Filer section is used to indicate the party or parties on 
whose behalf the document is being filed.  It lists the parties associated with the 
selected case(s); the party type; the case number; and the short caption.  
 
1. Select the checkbox to the left of the appropriate filer(s).   
2. The Select All and Clear All buttons can be used to select or clear all 

checkboxes in the list. 

3. Event.  A piece of information selected from a list by the user to describe the 
document being filed. 

4. Event Category. A list used to describe the types of filings, which corresponds 

with the phases of an appeal or a specialized group of filings within each category. 
5. CM/ECF Relief.  An additional portion of an event transaction used to create a 

docket entry in a case, which further describes the transaction. Not all events will 
have a relief.  

6. Relief Category. A general topic, which include reliefs that may be selected for 
filing. 
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NOTE: The Note section is used to display a message to the filer. The messages 
are designed to help the filer navigate and avoid common errors.  

How to File a Brief/Appendix or Notice of Joinder 

1. Select “File a Document” from the Filing menu at the top of the Startup Page. 
The screen in Figure 9 will appear: 

 

Figure 9. Filing a Brief/Appendix or Joinder tendered 

 
 

2. Enter a case number in the Case field (make sure to use the correct format:  
yy-nnnn when entering the number in the field). Click out of the box or click 
“Tab” on your keyboard. 

 
NOTE: Case Lock.  This is a feature that locks the case and does not allow you to 
access the case if it is being used by a case manager.  If you receive a Case Lock 
error (Figure 38), please try again after 30 minutes; if you continue to receive an 
error contact the Clerk’s Office. 
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Figure 10. Case Lock Failure 

 
 

3. Next, you will need to select an Event Category from the menu on the left side of 
the screen. Selecting a category will bring up a number of corresponding filing 
event options on the right side. Select the corresponding event option for the 
item you wish to file. 

 
 
4. Click ‘Continue’ at the bottom of the screen (see Figure 39). 
 

Figure 11. Case Selection 
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Figure 12. Docketing Brief/Appendix Tendered 

 
 
5. On the next screen, you will be prompted to Select the party filer, attach the 

PDF for the pleading, and select the names of the party or parties that must be 
served, enter the service date and select the method of service. If the party filing 
the brief does not appear in the Party Filer list, enter the name of the party or 
parties in the Name of Non-party Filer box located in the Additional 
Information section of the screen. Depending on the type of pleading you are 
filing, you may be required to enter additional information e.g. Name of Non-
party filer.  You will also be required to select the type of brief being filed from 
the available drop-down list of options, and whether or not the brief has been 
corrected or amended. The list of available brief types is: Opening Brief, 
Opening Brief w/Appendix, Reply Brief, Joint Appendix, Court Ordered 
Supplemental Brief/Appendix, Intervener Brief, Amicus Curiae Brief, Letter 
Brief and Notice of Joinder. 

 
6. Under the Additional Information section, enter the non-party name or names 

in the Non-party filer text box if there is not a Party on the appeal e.g. Amicus 
Brief of Flubber Rubber Company. 
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Figure 13. Party Filers 

 
 
 
7. Enter the date of filing into the Service Date field.  Also, enter the method of  
     service and check the party that you would like to be served (see Figure 42). 
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Figure 14. Service 

 

 
TIP: If the information is incorrect, use the “Back” button or “Cancel” the filing 
and start over. Click the “Continue” button to move to the next screen if the 
information is correct. Review the Brief Checklist that appears under the PDF 
Document Section. 
 
8. To attach a PDF to your entry, click the ‘Browse’ button in the PDF Document 
    section on the screen. This will cause a pop-up screen to appear. Locate the 
    appropriate PDF on your computer and select it. To ensure the correct file will be 
    uploaded prior to committing the transaction you may view the document by     
    clicking the “View” button.  Clicking the “View” button launches the selected file. 
    You may also edit the “Description” field to state what you are filing (for 
    example, “Docketing Statement,” “Appellant’s Brief,” etc.).  After selecting 
    “Continue” the docket text pop up will appear with the service information, this 
    will display how your entry will appear on the court’s docket, verify the 
    information before clicking “Continue”.  
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Figure 15. PDF Document 

 

 
 

9. To file additional documents select “Add Another” and complete the 
“Description” Field.   

Figure 16. Add an Additional PDF Document 
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10. Review the Docket text, if it is incorrect select the “Back” button to correct. 
 

Figure 17. Docket Text 

 
 
11.  This is your last opportunity to review the text prior to filing the document on 

the docket. Again, this text cannot be edited here. If the text is incorrect, click 
the Back button. If correct, select Submit to file the document on the docket 
report. This is the Event Review screen. The pop up will appear, Select 
“Submit” to complete the transaction. 
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Figure 18. Event Review 

 

 
12. After selecting Submit, an event confirmation will pop up confirming that the      
 docketed transaction has been completed: 

Figure 19. Event Docketed 

 

 
TIP: In addition, for most transactions, a new browser window will launch and the 
following screen will appear. This is the Notice of Docket Activity (NDA). We highly 
recommend that you print this screen for your records, and the embedded hyperlink 
content as it is available to you with one free look. CM/ECF will produce a Notice of 
Docket Activity and it shall be the equivalent of service by U.S. mail. The Notice of 
Docket Activity will contain a hyperlink to the document in PACER.  
 
Under the conditions set forth in the paragraph below, recipients of Notices 
of Electronic filing will be allowed one (1) “free look” at the document and may 
view, print, or download it. After the one “free look,” normal PACER usage fees 
apply. The hyperlink to access the document will expire after the earlier of these 
two events: the first use or 15 days.  
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(CAUTION: double clicking the hyperlink instead of single clicking it will use up the 
one “free look.”).  You may close this screen after you are done.   
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Figure 20. Notice of Docket Activity 
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13. Remember to logout when you are finished.  

Figure 21. Logout of CM/ECF 

 
 
NOTE: If your computer is idle for 50 minutes you will receive a warning message, 
you may click OK to remain logged in.  The warning will display for 5 minutes, if 
you do not click OK you will be automatically logged out. 
 
TIP: Six bound paper copies of all briefs, in the format specified by the Federal 
Rules of Appellate Procedure and the Federal Circuit Rules, must be filed with the 
court within 5 days after the brief has been accepted for filing by the court.  See 
ECF-10, Paper Copies of Electronic Filings, of the Administrative Order. 
 

HOW TO FILE A MOTION  

(Example: Motion for extension of time to file a brief and appendix.)  

1. From the Filing menu select File a Document. 
2. In the upper left part of the window type the case number in the Case box and 

press the Tab key (See Figure 50) 

TIP: The case number and title now appear below the menu bar in the File a 
Document window. In addition, the case number and title appear in the Case 
Selection box in the lower part of the window.  
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Figure 22. Filing a Motion 

 

 

3. In the categories list on the left (see Figure 51), select the MOTIONS button. 
The window on the right is updated to show a list of all possible filing types, 

(MOTION FILED, MOTION FILED IN FORMA PAUPERIS AND STATUS 

REPORT WITH MOTION FILED).  

4. In the list of filing types, labeled Select One, select the type of document to be 
filed. 

TIP: To file a combined status report and motion, select Status Report with Motion 
Filed; to file a motion to proceed In Forma Pauperis, select Motion Filed In Forma 
Pauperis; for all other motions select Motion Filed. 

Figure 51 is an example of this screen with the filing category MOTIONS, and the 
filing type MOTION FILED selected. 
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Figure 23. Event selected, Motions and Motions Filed 

 

Figure 24. Target Case Information 

 
 

1. Select Continue 

2. A Docketing Motion Filed Window will appear to remind you that you may need 
to select more than one relief. 

3. Click OK.  See Figure 53. 
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Figure 25. Message - selection of more than one relief 

 

4. In the Party Filer section, select the party or parties on whose behalf the motion 
is being filed. Click in the appropriate checkbox to the left of the Filer column in 
the Party Filer area. A pro se filer must select her or his name from the list. 

Figure 26. Party Filer 

 
 
 
5. NOTE: If the party on whose behalf the document is being filed does not appear 

in the Party Filer list above, enter the name(s) of the party in the Name of non-
party filer: section which can be found under Additional Information. 

 
6. Select the type of CONSENT field from the drop-down menu (Unopposed, 

Opposed, Partial consent, Not Addressed). 
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7. Enter the SERVICE DATE of the filing. This date should be the same date on 
your certificate of service.  

 
(TIP: “Right Click” in the SERVICE DATE field then click on Select Date from 
Calendar to generate a calendar from which you can choose the appropriate date). 
Also, check the means of service by using the checkboxes beneath the Service Date 
box to select the method(s) of service. The screen now should look similar to the 
example in Figure 42. For example, if service is made through the ECF system you 
should select Email.  

Figure 27. Filing a Motion Checklist 

  
 

8. Attach your motion by clicking on the Browse button.  
 
9. View all document(s) prior to attaching to ensure it is the correct document(s). 

Also, check the file size of each document. You can check the file size by resting 
your cursor over the filename and a box will appear with the file size or you can 
right click your mouse over the highlighted filename, select properties and view 
the file size. The maximum file size for a document is 60 MB.  
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TIP: To double-check the document before attaching it, select “Browse” and locate 
the file you believe to be the correct one.  Right-click on the file and use the “Open 
with …” option to view it in your .pdf program. 
 
10.  Click Open to attach the document to the event.  

 

Figure 28. Add PDF to a Case 
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11. If you wish to add another document, click Add Another and repeat directions 

from steps 13 and 14.  
 

     Figure 29. Add Another PDF 

 

12. Select relief from drop down (Figure 58). You must include a description for any 
additional document(s) attached. (e.g.: exhibits).  

 
13. Choose the appropriate relief category and description from the drop-down 

menus. For this example the Briefing category is selected and the relief 
description is extend time to file appellant/petitioner principal brief. Click 
Apply.  

 
14. Your selection will appear in the box below. If your document includes an 

additional relief, please repeat directions from step 11.  
 
15. Click Continue when all of your types of reliefs have populated in the Selected 

Reliefs box. 
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Figure 30. Relief Category and Description 

 
 

16.  Enter the Date and Time you would like to “Extend the Time to”.   
 
TIP: Motions to extend beyond 14 days require an affidavit.  Select Continue to 
file your Motion.  
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Figure 31. Motion Filed to Extend Time 

 
 

17. The docket text will appear for your review (see Figure 60). The text cannot be 
edited. If the information is incorrect, use the Back or Cancel buttons to start 
over. Click the Continue button to move to the next screen if the text is correct.  
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Figure 32. Motions Docket Text 

 
 

18. Event Review. This is your last opportunity to review the docket text prior to 
filing the document on the docket. Again, this text cannot be edited. If the text is 
incorrect, click the Back button and return to the entry to start over. If correct, 
select Submit to file the Motion for Extension of Time.  

CAUTION: Clicking Submit commits the user to filing the motion. Click the Back 
button to make any necessary changes. 

Figure 33. Motion Event Review 
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19. The transaction confirms that the event has been completed and placed on the 
Court’s docket.  Click OK to receive your NDA. 

TIP: If the notice does not appear in a new browser window, check the browser's 
pop-up blocker settings. Pop-ups from the Court’s site must be allowed. 

Figure 34. Confirmation Screen, Event Docketed 

 
 

 
20. Select OK to generate your NDA. You will receive an email message containing 

the Notice of Docket Activity. 
 

Figure 35. NDA for Motions 
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NOTE: The File a Document screen re-opens automatically to file another 
document. If no further documents are to be filed, log out of the File a Document 
page, or just close that screen and logout from the startup screen. 
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HOW TO FILE A PETITION FOR REHEARING OR 
HEARING/REHEARING ENBANC 

Note: The Rehearing and En Banc Petitions Category should be used to file a 
Petition for Hearing En Banc. 

 
1. From the Filing menu select File a Document. 
 
2. Enter the case number in the Case field and press Tab. 
 
3. In the categories list on the left, select Rehearing and En Banc Petitions.  

The window on the right is updated to show a list of all possible filing types 
(Petition Filed, Reply Filed, Response/Opposition to a Motion or 
Petition). 

 
4. Select Petition Filed from the right side of the screen. 

Figure 36 Filing a Petition 

 

 
5. Click Continue.  
 

Select File a 
Document 

Type in the 
Case Number! 

 Select Petition Filed, Reply 
Filed, or 
Response/Opposition to a 
Motion or Petition as 
applicable.   

Select 
Rehearing and 
En Banc 
Petitions 
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6. In the Party Filer section, select the party or parties on whose behalf the petition 
for rehearing or En Banc petition is being filed.  Click the appropriate checkbox 
to the left of the Filer column in the Party Filer area. 

 
7. In the relief section select En Banc and Rehearing Petitions from the 

category drop-down (see Figure 65).  
 

Figure 37. Selecting Parties for Petition 
 

 
 
8. From the description drop-down, select the type of hearing and/or rehearing 

being filed.  (Note: more than one relief or type of petition may be selected.  After 
each selection click apply.  Your chosen options appear in Selected Reliefs box). 

5. Select the party for which 
the petition for 
rehearing/En Banc, reply, 
or response is to be filed. 

6. Select En Banc 
and Rehearing 
Petitions  
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Figure 38. Selecting Relief or Petition Type 

 

9. Click Continue. 
 
10. In the service section, enter the SERVICE DATE of the filing.  This date should 

be the same date on your certificate of service. Also select who the document was 
served on and how it was served   

 
11. Attach the petition by clicking on the Browse button.  View all document(s) 

prior to attaching to ensure it is the correct document(s).  Click Continue. 
 
12.  The docket text will appear for your review. The text cannot be edited. If the 

information is incorrect, use the Back or Cancel buttons to start over. If the 
text is correct, click the Continue button to proceed to the next screen.  

 
13. Event Review. This is your last opportunity to review the docket text prior to 

filing the document on the docket. Again, this text cannot be edited. If the text is 
incorrect, click the Back button and return to the entry to start over. If correct, 
select Submit to file the petition. 

 
CAUTION: Clicking Submit commits the user to filing the petition. Click the 
Back button to make any necessary changes. 

 
14. The transaction confirms that the event has been completed and placed on the 

Court’s docket.  Click OK to generate your NDA.   You will receive an email 
message containing the Notice of Docket Activity.  You may print or save the 
NDA as proof that the petition has been transmitted to the court. 
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 EVENTS AND EVENT CATEGORIES 

Event Category Event Comments 
Briefs 
  Brief/Appendix Or Joinder 

Tendered                                                                                                                                                                         
Omit unnecessary cover or 
transmittal letters; use event for 
all non-confidential briefs, 
appendices and joinders; the brief 
is not considered filed until it’s 
accepted by the clerk’s office 

  Brief /Appendix or Joinder 
Tendered Confidential                                                                          

You must use this event for all 
confidential briefs/appendices 
and joinders; any pdfs uploaded 
using this event will not be 
available for viewing, you must 
serve the parties by alternate 
method 

  Notice Of Correction To Brief                                                                        This is required only if you are 
filing a correction to a brief 
previously accepted/filed by the 
clerk; this event should be used in 
conjunction with the brief tendered 
event.  In other words, when filing 
a notice of correction, the  
corrected brief, appendix or 
joinder, should also be filed using 
the appropriate brief tendered 
event 

  Notice Of Intent To File Briefs On 
CD-ROM                                                            

  

Calendar 
 Citation of Supplemental 

Authority 
 

  Memo In Lieu Of Oral Argument                                                                          
 Notice Regarding Conflicts with 

Argument Dates 
 

  Response To Oral Argument Order                                                            Event can also be found in the 
Response/Reply category 

 Response to Request from Panel 
at Oral Argument 

 

Caption 
  Notice Of Objection To Caption                                                                       Use only if there are clear errors in 

the caption (e.g., misspelling, 
incorrect designation); for more 
substantial findings, such as a 
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Event Category Event Comments 
missing party, a motion should be 
filed 

Confidential 
Document 

    

 Brief/Appendix or Joinder 
Tendered Confidential 

You must use this event for all 
confidential briefs/appendices 
and joinders; this event will not 
send electronic notification, you 
must serve the parties by alternate 
method 

  
 

Sealed Or Confidential Document 
Submitted                                                            

Use this event for any 
Confidential Document, other 
than a brief or appendix; any pdfs 
uploaded using this event will not 
be available for viewing and must 
be served on parties using an 
alternate method 

Forms and 
Certificates 

    

  Bill Of Costs Filed                                                                                    
  Cert Of Compliance Modification 

of Protective Order (R11/17)                                                                   
Report agreement in trial court 
(Rule 11) or agency (Rule 17) 
regarding modification of 
protective orders 

  Certificate Of Compliance 
Transcript (R10)                                                                   

 

  Certificate Of Interest Filed                                                                        Government attorneys and pro se 
litigants are not required to file a 
certificate of interest; this filing 
should occur once per party OR 
group of parties represented by the 
same attorney 

  Corrected Certificate Of Service                                                                       
  Docketing Statement Filed                                                                            A docketing statement is not 

required in appeals where a pro se 
appears as a party 

  Entry Of Appearance Filed                                                                            Each attorney must file a separate 
entry of appearance and include all 
parties they represent in the 
appeal; use of ”et al” is prohibited; 
only one attorney can be 
designated as principal counsel for 
the party  

  Statement Concerning Required in appeals from the Merit 
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Event Category Event Comments 
Discrimination R 15c                                                            Systems Protection Board; due 14 

days from the date of docketing 
  Statement Of Compliance With 

FCR 33                                                                  
Settlement discussion 

  Transcript Purchase Order Form 
Filed                                                                 

  

  USERRA Notification Form                                                                             For Merit System Protection Board 
appeals only (if applicable) 

Letters and 
Notices 

    

  Letter Or Notice From Party                                                                          If Requesting Specific Relief, Use 
Motion Filed Event instead 

 Notice Of Correction To Brief                                                                        This is required only if you are 
filing a correction to a brief 
previously  accepted/filed by the 
clerk; this event should be used in 
conjunction with the brief tendered 
event.  In other words, when filing 
a notice of correction, the  
corrected brief, appendix or 
joinder, should also be filed using 
the appropriate brief tendered 
event 

  Notice Of Election Per 37 CFR 
Section 1.983(E)                                                       

  

 Notice Of Intent To File Briefs On 
CD-ROM                                                            

 

 Notice Of Objection To Caption                                                                       Use only if there are clear errors in 
the caption (e.g., misspelling, 
incorrect designation); for more 
substantial findings, such as a 
missing party, a motion should be 
filed 

  Notice Of Paper Filing                                                                                 
  Letter or Notice Regarding 

Bankruptcy                                                                
  

  Notice Re Conflicts With 
Argument Dates                                                       

  

  Notice Re Post-judgment Motions 
(PN4)                                                                 

  

 Citation of Supplemental 
Authority 

 

Miscellaneous     
 Additional Volumes of Document  
  Agreed Statement In Lieu Of 

Certified List                                                           
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Event Category Event Comments 
  Amended Notice Of Appeal                                                                             Use this event to file an amended 

notice of appeal or petition for 
review; An amended notice of 
appeal must first be filed with the 
district court, it is not necessary to 
file a courtesy copy with this court 

  Citation Of Supplemental 
Authority                                                                   

  

  Notice Of Joinder To Document                                                                        Used when joining in another 
party’s document which has 
already been filed; do not use for 
joinders to briefs 

  Other Document Submitted                                                                               
  Request To Reissue Opinion/Order 

as Precedential                                                     
  

Motions     
  Motion Filed                                                                                         More than one relief may need to 

be selected, depending on nature of 
motion 

  Motion Filed In Forma Pauperis                                                                      This pdf on this event is restricted 
and is not available to the public 

 Status Report with Motion Filed If a motion is imbedded within the 
status report, the title of the 
document should so reflect and the 
event required is: Status Report 
with Motion Filed. This event will 
allow the user to select the type of 
relief requested in the motion. 

Rehearing and En Banc Petitions    
  Petition Filed Use this event only for filing 

petitions for panel or en banc 
rehearing or en banc hearing 

  Response/Opposition to a Motion 
1or Petition 

Respond to a pending motion or 
petition. 

  Reply Filed                                                                                          Event can also be found in the 
Response/Reply category 

 Response/Opposition with 
Incorporated Motion 

Respond to a pending motion or 
petition and file a motion. Event 
can also be found in the 
Response/Reply category 

Response/Reply     

  Reply Filed                                                                                          Used to respond to a 
Response/Opposition which has 
already been filed 
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Event Category Event Comments 
 Response to Court Order  
  Response to Oral Argument Order   
 Response/Opposition to a Motion 

or Petition 
Respond to a pending motion or 
petition 

  Response/Opposition To Bill Of 
Costs Filed                                                           

  

 Response/Opposition to Other 
Document 

 

 Response/Opposition with 
Incorporated Motion 

Respond to a pending motion or 
petition and file a motion. Event 
can also be found in the Rehearing 
and En Banc Petitions category 

Status Reports     
  Status Report Filed                                                                                  Only use when not accompanied by 

a motion 
  Status Report With Motion Filed                                                                      If a motion is imbedded within the 

status report, the title of the 
document should so reflect and the 
event required is: Status Report 
with Motion Filed. This event will 
allow the user to select the type of 
relief requested in the motion. 
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RELIEF AND RELIEF CATEGORIES 

Relief 
Category 

Relief Comments 

Amicus 
  amicus response to motion   

  

file amicus brief on en banc or 
rehearing petition 

relief can also be found in the 
rehearing and en banc petitions 
category 

  

leave to file an amicus curiae 
brief 

brief must be submitted with 
motion (2 separate events 
required). 

Attorneys 
  appear pro hac vice   

  

file Entry of Appearance of new 
counsel 

if an entry of appearance is first 
submitted within 30 days of the 
scheduled argument, the attorney 
must file a motion for leave to file 
the entry of appearance  

  

substitute attorney if an attorney from another law 
firm has already filed an 
appearance as principal counsel, 
and an attorney from a separate 
firm wishes to be principal, a 
motion to substitute attorney 
must be filed.  Counsel should 
indicate whether or not the 
previous counsel will or will not 
remain on the case. 

  

withdraw attorney An attorney who has already 
entered an appearance and now 
wishes to withdraw his or her 
appearance from representation 
of the party or parties (relief can 
also be found in the withdraw 
category) 

Briefing 
  adopt appendix   
  adopt brief   
  set briefing schedule   
Calendar/Argument 

  
additional time at oral 
argument 

  

  allow argument   
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Relief 
Category 

Relief Comments 

  
hear case before the same 
merits panel 

for related or companion cases 

  in camera proceedings   

  
recuse judge relief can also be found in the 

disqualify/recuse category 
  reschedule argument   
 schedule oral argument  
 treat as companion case  
  waive oral argument   
Caption 

  
modify the official caption use for substantial findings in the 

caption, such as a missing party 

  
substitute party relief can also be found in the 

withdraw category 
Case Termination 
  limited remand   

  
terminate appeal use for opposed and unopposed 

motions 

  
terminate cross/consolidated 
appeal 

motion filed in cross/consolidated 
appeal only 

Consolidation 

  
consolidate appeals motion should be filed in each 

appeal 
  deconsolidate appeals motion only filed in lead case 
Correct or Supplement 

  
correct document use for documents other than 

brief or appendix 
  correct/supplement other   

  
correct/supplement record on 
appeal 

  

  file corrected appendix   
  file corrected brief   
  file supplemental appendix   
  file supplemental brief   

  

supplement document motion to supplement a document 
that is not a brief/appendix; 
should be prepared as two 
separate PDF files and uploaded 
to the motion filed event. 
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Relief 
Category 

Relief Comments 

Costs or Fees 

  
allow costs under R.39 refers to fees incurred for 

preparation of briefs/appendix 

  

attorney fees and expenses all other attorney fees (attorney 
rates/hours, analysis fees, etc.) 
Fed. Cir. R. 47.7 

  
EAJA attorney fees and 
expenses 

  

  waive fees   
Disqualify/Recuse 
 disqualify attorney  
 disqualify law firm  
  recuse judge   
Emergency Stay R.8/R.18 

  

emergency stay pending appeal relief can also be found in the stay 
category; should be filed in paper 
form only if appeal has not been 
docketed prior to filing of motion 

  
lift injunction relief can also be found in the stay 

category 

  
lift stay pending appeal relief can also be found in the stay 

category 

  

temporary injunction pending 
appeal 

relief can also be found in the stay 
category; should be filed in paper 
form only if appeal has not been 
docketed prior to filing of motion 

Exhibits 
  transmit physical exhibits   
Expedite 
  expedite appeal   
  expedite briefing schedule   
  expedite decision/ruling   
  expedite hearing   

  
expedite response or reply relief can also be found in the 

response/reply category 
Extend Time 
  extend time to file (other)   

  
extend time to file a response to 
en banc or rehearing petition 

  

  
extend time to file amicus brief relief also used if filing brief out 

of time 
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Relief 
Category 

Relief Comments 

  

extend time to file 
appellant/petitioner principal 
brief 

relief also used if filing brief out 
of time 

  

extend time to file 
appellee/respondent/cross-
appellant principal brief 

relief also used if filing brief out 
of time 

  
extend time to file appendix relief also used if filing brief out 

of time 
  extend time to file bill of costs   

  
extend time to file cross-
appellant's reply brief 

relief also used if filing brief out 
of time 

  
extend time to file intervenor's 
brief 

relief also used if filing brief out 
of time 

 
extend time to file petition for 
rehearing 

used with Motion Filed, not 
Petition Filed 

  
extend time to file reply brief relief also used if filing brief out 

of time 

  
extend time to file 
response/reply 

relief can also be found in the 
response/reply category 

  
extend time to file 
supplemental appendix 

  

  
extend time to file 
supplemental brief 

  

  extend time to obtain counsel   
In Forma Pauperis 

  

leave to proceed in forma 
pauperis 

access to the document is 
restricted and is only available to 
users associated with the case 

Intervene 
  intervene   
Judicial Notice 
  take judicial notice   
Mandate 
  issue mandate   
  recall mandate   
  reschedule mandate   
  stay mandate   
Other 
  clarify   

  
deactivate appeal relief can also be found in the stay 

category 
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Relief 
Category 

Relief Comments 

  modify protective order   

  
other relief use only when request cannot be 

described by another relief 

  
reactivate appeal relief can also be found in the stay 

category 
  seal case   
  seal document   
  set briefing schedule   
  to vacate   
  unseal case   
  unseal document   
Precedential 
  reissue as precedential   
Reconsider 
  reconsider order   
  reconsider order en banc   
  reconsider rejected brief   
Rehearing and En Banc Petitions 

  
extend time to file a response to 
en banc or rehearing petition 

relief can also be found in the 
extend time category 

  
extend time to file petition for 
rehearing 

relief can also be found in the 
extend time category 

 
file amicus brief on en banc or 
rehearing petition 

relief can also be found in the 
amicus category 

Reopen 

  

reopen appeal use for motion to reinstate and 
motion for reconsideration of 
terminated appeal 

Response/Reply 

 
expedite response or reply  

 
extend time to file 
response/reply 

relief can also be found in extend 
time category 

  

leave to file a response/reply only use when responding to 
document that does not  already 
allow for response in accordance 
with rules 

Sanctions/Damages 
  sanction party   
  sanction person   
Stay 

U . S .  C O U R T  O F  A P P E A L S  F O R  T H E  F E D E R A L  C I R C U I T  



C M / E C F  U S E R  G U I D E  V e r . 1 . 6  P a g e  | 64 

Relief 
Category 

Relief Comments 

  continue stay   
 deactivate appeal  
 emergency stay pending appeal  
 lift injunction  
  lift stay   
 lift stay pending appeals  
 reactivate appeal  
  stay appeal   

 
temporary injunction pending 
appeal 

 

Strike 
  strike brief used by opposing party 
  strike document used by opposing party 
Waive Requirement 
  allow e-filing   

  
exempt attorney from 
electronic filing 

  

  
exempt case from electronic 
filing 

  

  
exempt document from 
electronic filing 

  

  waive other requirement   

  
waive requirements of brief or 
appendix 

  

  
waive requirements of rule 
27(f) 

only use prior to submission of 
document 

Withdraw 
 substitute party  
 withdraw attorney  

  

withdraw brief or appendix used by party who filed the brief 
or appendix and who now wishes 
to withdraw the filing 

  

withdraw document used by party who filed the 
document and who now wishes to 
withdraw the filing 

  withdraw party   
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APPENDIX  

Redaction Methodology Suggestions 

It is the responsibility of the party to redact any and all sensitive material from the 
documents submitted electronically or in paper to the court.  Sensitive material 
includes social security or taxpayer-identification numbers, dates of birth, names of 
minor children, and financial account numbers (See Fed. R. App. P. 25(a)(5)). The 
items listed above, while not an exhaustive list, provide possible suggestions for 
redacting sensitive information from documents. 
 
Completely delete sensitive information in the original word processing document 
and replace it with innocuous filler characters such as ‘X’, save it, then convert the 
document to a PDF. 

 
Removing Sensitive Metadata in Word 2007 Documents: 
1. Open the Office document that you want to inspect for hidden data or personal 

information. 

2. Click the Microsoft Office Button, click Save As, and then type a name in the 
Filename box to save a copy of your original document. 
 

Important: It is a good idea to use the Document Inspector on a copy of your 
original document because it is not always possible to restore the data that the 
Document Inspector removes. 
 
1. In the copy of your original document, click the Microsoft Office Button, point to 

Prepare, and then click Inspect Document. 
2. In the Document Inspector dialog box, select the check boxes to choose the types 

of hidden content that you want to be inspected. 

3. Click Inspect. 
4. Review the results of the inspection in the Document Inspector dialog box. Click 

Remove All next to the inspection results for the types of hidden content that you 
want to remove from your document. 
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Removing Sensitive Metadata in Word 2010 Documents 
 
1. Open the document and save a copy to prevent loss of metadata in your 

original. Click File and bring up Backstage View. Under Prepare for Sharing 
and from Check for Issues options, click Inspect Document. 

2. This will bring up Document Inspector dialog, listing multitude of options for 

inspecting; Comments, Revisions, Version, Document Properties, Personal 
Info, XML Data, Headers, Footers, Watermarks, Invisible Content, and 
Hidden Text, etc. Enable desired options available in the list and click Inspect. 

3. Once inspection is completed, you can remove the inspected elements from the 
document by clicking Remove All with each option selected. 

4. On clicking Remove All, all the specified elements will be removed from the 

document. 
5. Create the PDF. 

 
Removing Metadata from WordPerfect 13 and WordPerfect 15 
 
1. Select File, and Save Without Metadata. 
 
Additional Redaction Information  

 
1. Adobe Acrobat’s redaction tool is effective for removing sensitive material 

directly from a PDF file. Please see your version of Acrobat’s Help instructions 
regarding the proper use of this tool. 
� Redaction in Adobe Acrobat 8  
� Redaction in Adobe Acrobat 9  
� Redaction in Adobe Acrobat 10 (Adobe Acrobat X) 

 
2. It is recommended that a redacted document be cut and pasted into another 

document. If the redaction succeeded, no redacted text should be transferred. 
 

How to determine whether a PDF is text-searchable 

After opening the PDF, try searching for a word known to be in the document 
(preferably a word that appears on several different pages) by entering the word 
into the search box. 
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Figure 39. Determine if PDF is text searchable 

 
 

If the message below appears, the document is not text-searchable. 

Figure 40. Message - Non text searchable 

 
 
Alternatively, use the mouse to highlight a word in the text. If a single word cannot 
be highlighted and the entire page turns blue to indicate it is an image, the text is 
not searchable. 
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How to make a scanned PDF text-searchable 

• Adobe Acrobat 8 
• Adobe Acrobat 9 
• Adobe Acrobat X 

 
The following instructions apply to making a PDF text-searchable in Adobe Acrobat 
Professional or Standard: 
Click on Document > OCR Text Recognition > Recognize Text Using OCR.   

Figure 41. OCR Text Recognition. 

 
 
The text recognition process will proceed page by page. Please note that for a very 
long document the process may take several minutes to complete. Enabling text-
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search ability in multiple documents at once can be accomplished through batch 
processing by following these instructions on the Adobe site. 
 
When all the pages are processed, try the same search to verify that the document 
now is text-searchable. 

Dividing a PDF 

Dividing an oversized PDF 
CM/ECF will not accept filing of a single PDF document that exceeds 80 MB in file 
size. An entire appendix will often exceed that size; therefore, it must be divided 
into smaller PDF documents unless there is no reasonable way to accomplish such 
division. (Note: The Court will accept a filing that contains no more than 4 
attachments, each not exceeding 20 MB in file size, per document. If there are more 
than 4 attachments or any one of the 4 attachments exceeds 20 MB in file size, the 
filer must submit the entire appendix as one PDF on CD or DVD.   See local rule 
ECF-8. 
 
To determine the size of a PDF, open the document and click on File > Properties 
See below Adobe File Properties 
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Figure 42. Adobe File Properties 
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Figure 43. Adobe File Properties 

 
 
Open the Description tab at the top left of the dialog box that opens. The file size 
in MBs appears on the third line from the bottom of the dialog box. In the example 
below the 1763-page joint appendix is 32 MB). It will have to be split into at least 
two separate, smaller PDFs for filing purposes. 
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To use Adobe Acrobat Professional or Standard to split the oversized PDF into 
several parts, all smaller than 20 MB, follow the directions below. A filer using 
another software package to create PDFs must consult the software vendor for 
instructions on splitting documents. 
 
1. Open the oversized PDF and click on Document in the menu bar at the very 

top of the document. Scroll down and click Split Document. 

Figure 44. Splitting the PDF 

 
 

2. In the dialog box that opens, select Split document by File size, and enter 10 in 
the Max MB: box). Then either click (1) Output Options to rename the 
separate files and save them in a different folder, or (2) click OK to use the 
automatic file-naming function. 

 
Note: Use Output Options only to save the separate files in a folder different 
than that containing the original document or to assign specific names to the 
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separate files. If Output Options is not selected, the default folder and file names, 
as described below, are used. 

Figure 45. Set the Max File Size 

 
 
 

3. The Output Options dialog box, allows a filer to choose a target folder and add a 
label to the file name(s). A filer can decide whether to add the label and part 
number before or after the original name and type the selected label in the Use 
label: box. 
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Figure 46. Output Options 

 
 

The split parts of the document are saved in the folder with the labels entered. 

Figure 47. Display of Split parts 

 
 

U . S .  C O U R T  O F  A P P E A L S  F O R  T H E  F E D E R A L  C I R C U I T  



C M / E C F  U S E R  G U I D E  V e r . 1 . 6  P a g e  | 75 

4. If the Output Options are not used, the split parts of the document 
automatically are saved in the same folder as the original, and the label "Part#" 
is added at the end of the original file name. 

 

Figure 48. Split Documents in File Folder 
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Solutions for Issues Reported with Adobe 9 

A few attorneys are having problems when filing a document in appellate CM/ECF 
that had been created in Adobe 9. There is a compatibility problem with this 
version of Adobe and the CM/ECF program. This issue will probably not be resolved 
until the end of the year. Below are some suggested solutions when creating a PDF 
Document with Adobe 9.   
 
1. If possible, create the document in Adobe 8 instead. 
 
2. If that is not possible then do the following: 

 
� If using Adobe 9 to scan a document, go to the Advanced menu and choose 

PDF Optimizer.  
 
� In the window that opens: 

• Find the Compatibility box: choose Acrobat 8 or below. 
• Click the Save button and enter a name for this setting, e.g., CMECF. 
• Click the OK button; the optimizing steps will execute on the 

document that is open. 
 

NOTE: These steps only have to be done once; thereafter, each time the attorney 
opens Adobe 9, it will remember this setting. So the next time a document is 
scanned, the attorney would go to the File menu, choose Save As and in the Save As 
Type drop-down, select Adobe PDF Files, Optimized. This will automatically save 
the file using the setting created above. 

 
� For Microsoft Word, when the document is ready for PDF conversion, go 

to the Adobe PDF menu: 
 
• Select the Change Conversion Settings menu. 
• Click on the Advanced Settings button.  
• Find the Compatibility drop-down list, select Acrobat 8 or below -- click 

the OK button. 
• In the next window, in the File name box, type: CMECF and click the 

Save button. 
• In the next window, click the OK button. 

 
� Then, again in the Adobe PDF menu, continue as you normally would and 

choose the Convert to Adobe PDF link. The steps above only have to be done 
once; Word will remember the Compatibility selection each time it is 
launched. 
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� For WordPerfect, when the document is ready for PDF conversion, follow 
the usual steps: go to the File Menu, select Publish To, and then choose PDF. 
This will bring up a window: 

• In the Compatibility box: choose Acrobat 8 or below. 
• Go to the PDF style drop-down, click the "+" button and add a 

"CMECF" style. 
• Click the OK button. 

 
NOTE: The steps above only have to be done once; WordPerfect will remember the 
Compatibility style created above each time it is launched. 
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ECF CHECKLIST   

Check for these common mistakes before submitting a transaction. 
ECF CHECKLIST 

□ Attorney filer’s firm, mailing address, and email address 
have been updated through PACER 

□ Attorney filer is properly registered as an active ECF filer 
(has a user name and password) 

□ Attorney signing the document has properly entered an 
appearance in the appeal 

□ Document format complies with requirements in FRAP, 
FCR, and ECF rules 

□ Document title reflects all relief requested 
□ Document includes the required electronic signature of an 

attorney who has entered an appearance in the appeal, or 
contains an affidavit of signature authority 

□ Document includes certificate of service 
□ Document redacts sensitive personal identifying 

information (or a confidential version is being filed) 
□ Document omits unnecessary cover letter or transmittal 

letter 
□ PDF complies with file size requirements and limits 
□ PDF is text searchable 
□ PDF is complete and legible Filing is timely (before 

midnight Eastern Time on the date due) 
□ Filing is NOT being made on a cross- or consolidated appeal 
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docket  (NOTE: all filings in consolidated cases must be 
made on the docket of the LEAD case only, except for a 
motion to terminate a cross- or consolidated appeal) 

□ Select the correct event and/or relief  (NOTE: a filing may 
require more than one event or relief) 

□ Review the list of events/reliefs, or call the Clerk’s Office 
□ Select the proper CONFIDENTIAL event for filing 

confidential versions of documents 
□ Serve paper copies on non-ECF filers (including those not 

represented by counsel) 
□ Serve confidential version on other parties by alternate 

method 
□ Transmit paper copies to the court, if required (see ECF-10) 
□ Correct your mistakes before submitting a transaction with  

the BACK and CANCEL buttons 
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